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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description
Category

Description

Product Name

HP EliteBook 8770w Mobile Workstation

Processors

Next Generation Intel® Core™ i7 processors, (support Intel Turbo Boost Technology):
●

i7-3520M, 2.90 GHz (Turbo up to 3.60 GHz), 1600 MHz, 4 MB L3 Cache, 4 threads, 35W

●

i7-3610QM, 2.30 GHz (Turbo up to 3.30 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W

●

i7-3720QM, 2.60 GHz (Turbo up to 3.60 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W

●

i7-2820QM, 2.3 GHz (turbo up to 3.4 GHz) quad-core processor, 8 MB L3 cache, 8 threads,
45W

●

i7-3820QM, 2.70 GHz (Turbo up to 3.70 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 45W

Next Generation Intel® Core™ i5 processors, (support Intel Turbo Boost Technology Technology):
●

i5-3320M, 2.60 GHz (Turbo up to 3.30 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W

●

i5-3360M, 2.80 GHz (Turbo up to 3.50 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W

Chipset

Mobile Intel QM77

Graphics

Support for the following graphics subsystem graphics boards (all feature OpenGL driver support):

Display

Memory

●

AMD FirePro M5950 XT-GL 1GB GDDR5 (DP 1.2 and Eyefinity Plus support)

●

NVIDIA Quadro 3000M, N14E-Q1 2 GB dedicated GDDR5 video memory

●

NVIDIA Quadro 4000M, N14E-Q3 2 GB dedicated GDDR5 video memory

●

NVIDIA Quadro 5010M, N14E-Q5 4 GB dedicated GDDR5 video memory

●

Display panel, 43.9 cm (17.3 in), High Definition Plus (HD+) Anti-Glare (AG) LED WVA without
webcam

●

Display panel, 43.9 cm (17.3 in), FHD AG LED WVA

●

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with webcam (not
available with HP Mobile Broadband) (includes display panel cable, 3 WLAN antenna and
cables, and 2 WWAN antenna and cables)

●

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without webcam
(not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN antenna and
cables, and 2 WWAN antenna and cables)

4 customer-accessible/upgradable memory module slots
Supports dual-channel memory
Supports up to 32,768 GB of system RAM
DDR3 1600MHz PC3-12800 SODIMMS
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Category

Description
Supports the following configurations:

Primary and
secondary storage

●

2048 MB total system memory (2048 × 1)

●

4096 MB total system memory (4096 × 1)

●

4096 MB total system memory (2048 × 2)

●

8192 MB total system memory (8192 × 1)

●

8192 MB total system memory (4096 × 2)

●

8192 MB total system memory (2048 × 4); only available on computer models equipped with a
quad-core processor

●

12288MB Total System Memory (4096MB x 3)

●

16384 MB total system memory (8192 x 2)

●

16384 MB total system memory (4096 x 4); only available on computer models equipped with a
quad-core processor

●

32768 MB total system memory (8192 x 4); only available on computer models equipped with a
quad-core processor

Supports 7.0 mm (0.28 in), 9.5 mm (0.37 in) or 12.7 mm (0.5 in) hard drives and 6.35 cm (2.5 in)
solid-state drive for primary and secondary storage.
Support for RAID 0/1/5
Supports the following Serial ATA (SATA), 7200-rpm drives:
●

750 GB

●

500 GB

●

320 GB

●

500 GB self encrypting drive (SED)

Supports the following 6.35 cm (2.5 in), solid-state drives (SSD):
●

256 GB Self Encrypting Drive (SED)

●

128 GB

●

160 GB

●

180 GB

●

24 GB

Upgrade bay
Supports the following 12.7 mm 6.35 cm (0.5 in) tray load SATA optical drives:
●

Blu-ray R/RE DVD±RW SuperMulti Double-Layer (DL) Drive

●

±RW SuperMulti Double-Layer Drive

●

DVD±RW SuperMulti Double-Layer Drive

●

DVD-ROM Drive (defeatured combo)

Supports a 7.0 mm, 9.5 mm, or 12.7 mm 500 GB hard drive, 7200 rpm
Supports "No Drive" option
Audio and video

Integrated dual-array microphone
High-definition (HD) audio with SRS premium sound
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Category

Description
2 stereo speakers
Integrated 720p HD webcam

Modem

56K V.92 data/fax modem
Supports “no modem” option
Modem cable not included

Ethernet

Intel® 82579LM Gigabit Network Connection
S3/S4/S5 wake on LAN
NIC power-down technology
Ethernet cable not included

Wireless

Integrated wireless local area network (WLAN) options by way of the following wireless
modules:
●

Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module

●

Intel Centrino Ultimate-N 6300, 802.11a/b/g/n WLAN module

●

Broadcom 802.11a/b/g/n 2x2WiFi Adapter

Three WLAN antennas (3) built into display assembly
Support for “no WLAN” option
Integrated wireless wide area network (WWAN) options by way of the following wireless
modules: (not available on computer models with Dream Color displays)
●

HP hs2340 HSPA+ Mobile Broadband Module

●

HP un2430 EV-DO/HSPA Mobile Broadband Module

WWAN antennas (2) built into display assembly (worldwide, 5-band)
Support for “no WWAN” option
Security provided by subscriber identify module (SIM) located inside battery bay
HP Integrated Module with Bluetooth 4.0
Support for “no WPAN” option
External media
card

One ExpressCard slot, supporting 16-bit and 32-bit (Cardbus) ExpressCard modules
Digital Media Card reader, supporting the following formats:
●

MultiMediaCard (MMC)

●

MultiMediaCard Plus (MMC+)

●

Secure Digital (SD) Memory Card

●

Secure Digital High-Capacity (SDHC) Memory Card

●

Secure Digital Extended Capacity (SDXC) Memory Card
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Category

Description

Ports

●

1394a (1)

●

Multi-pin AC port

●

Audio in (mono microphone)

●

Microphone input (stereo)

●

Audio-out (stereo headphone)

●

Display port (1.1a for NVIDIA, 1.2 for AMD)

●

Docking connector

●

eSATA/USB 2.0 combo

●

RJ-11 (modem)

●

RJ-45 (Ethernet, includes link and activity lights)

●

USB 3.0 (2)

●

USB 2.0 (2) 1 port with USB charging support

●

VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75 GHz (hot plug/unplug with
auto-detect)

Docking

Keyboard/pointing
devices

Supports the following docking stations:
●

HP 230W Docking Station

●

HP 230W Advanced Docking Station

●

HP USB 2.0 Docking Station

●

HP Essential USB 2.0 Port Replicator

●

HP LAN and USB Travel Hub

36.5 cm (14.4 in) full-size keyboard with separate numeric keypad, Dual Point (3 pointing stick
buttons and 3 TouchPad buttons) without backlight
36.5 cm (14.4 in) full-size keyboard with separate numeric keypad, Dual Point (3 pointing stick
buttons and 3 TouchPad buttons) with backlight (not supported in Japan or Brazil)
Spill-resistant DuraKeys coating
Spill-resistant DuraPad coating on TouchPad
Gestures enabled by default - 2 finger scrolling, 2 finger zoom (pinch)
TouchPad supports vertical scroll zone
Taps enabled as default

Power
requirements
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Supports the following AC adapters with localized cable plug support:
●

200W Slim Smart AC adapter

●

230W Slim Smart AC adapter

●

230W Smart AC adapter

●

3-wire plug (with ground pin)
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Category

Description
Support for the following batteries:
●

8-cell, 2.8 Ah (83 WHr) Li-ion battery

●

8-cell, 2.8 Ah (75 WHr) Li-ion battery (available with 3 year warranty only)

●

Supports 9-cell (73 WHr) polymer, HP ST09 Extended Life Battery (does not support HP Fast
Charge)

●

Supports 9-cell 3.0 Ah (100 WHr) cylindrical battery, HP BB09 Ultra-Capacity Extended Life
Battery (does not support HP Fast Charge)

HP Fast Charge Technology
Security

Integrated fingerprint reader
Integrated Smart Card reader
Preboot authentication (password, Smart Card)
Supports security lock
Trusted platform module (TPM) v.1.2 and TPM enhanced drive lock
Full volume encryption

Operating system

Preinstalled operating systems:
●

Windows® 7 Home Premium 64 (select models only)

●

Windows 7 Professional 64 (select models only)

●

Windows 7 Professional 32 (select models only)

●

FreeDOS

Operating system and Microsoft® Office preinstalled (not supported in Japan):
●

Windows 7 Professional 64 with Office 2010 Starter (select models only)

●

Windows 7 Professional 32 with Office 2010 Starter (select models only)

Restore media:
●

Windows 7 Professional 64 (select models only)

●

Windows 7 Professional 32 (select models only)

●

Windows 7 Home Premium 64 (select models only)

●

Windows 7 DRDVD (select models only)

●

Windows XP Professional 64 (service only)

Certified:
●

Microsoft WHQL

●

Novell

●

SuSE Linux
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Category

Description
Web-only support:

Serviceability
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●

Windows XP Professional 64 (select models only)

●

Windows XP Professional 32 (select models only)

●

Windows 7 Ultimate 64 (select models only)

●

Windows 7 Ultimate 32 (select models only)

●

Windows 7 Enterprise 64 (select models only)

●

Windows 7 Enterprise 32 (select models only)

End-user replaceable parts:
●

Memory module

●

Optical drive

●

SIM

●

WLAN module

●

WWAN module
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External component identification

Top
TouchPad

Component

Description

(1)

Left pointing stick button

Can be used with the pointing stick and functions like the
left button on an external mouse.

(2)

Center pointing stick button

Can be used with the pointing stick and functions like the
center button on an external mouse.

(3)

Pointing stick

Moves the pointer and selects or activates items on the
screen.

(4)

Right pointing stick button

Can be used with the pointing stick and functions like the
right button on an external mouse.

(5)

Right TouchPad button

Functions like the right button on an external mouse.

(6)

Center TouchPad button

Functions like the center button on an external mouse.

(7)

Left TouchPad button

Functions like the left button on an external mouse.

(8)

TouchPad

Moves the pointer and selects or activates items on the
screen.

(9)

TouchPad on/off button

Turns the TouchPad on and off.

Top
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Lights

Component
(1)

TouchPad on/off light

●

Off: The TouchPad is on.

●

Amber: The TouchPad is off.

(2)

Caps lock light

On: Caps lock is on.

(3)

Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

(4)

Num lock light

On: Num lock is on.

(5)

Wireless light

●

White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.

●

Amber: All wireless devices are off.

●

Amber: Computer sound is off.

●

White: Computer sound is on.

●

On: The computer is on.

●

Off: The computer is off or in Hibernation.

●

On: The Windows® calculator function is on.

●

Blinking: The calculator has been activated.

(6)

(7)

(8)
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Description

Mute light

Web browser light

Calculator light
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Buttons and fingerprint reader (select models only)

Component

Description

(1)

TouchPad on/off button

Turns the TouchPad on and off.

(2)

Power button

●

When the computer is off, press the button to turn on
the computer.

●

When the computer is on, press the button briefly to
initiate Sleep.

●

When the computer is in the Sleep state, press the
button briefly to exit Sleep.

●

When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.
To learn more about your power settings:
●

Windows 7—Select Start > Control Panel > System
and Security > Power Options.

●

Or refer to the HP Notebook Reference Guide.

(3)

Wireless button

Turns the wireless feature on or off but does not establish a
wireless connection.

(4)

Volume mute button

Mutes and restores speaker sound.

(5)

Web browser button

When Windows is running, press the button to open the
default Web browser.

(6)

Calculator button

Opens the Windows calculator function.

(7)

Fingerprint reader

Allows a fingerprint logon to Windows, instead of a
password logon.

Top
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Keys

Component
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Description

(1)

esc key

Displays system information when pressed in coMBination
with the fn key.

(2)

Function keys

Execute frequently used system functions when pressed in
coMBination with the fn key.

(3)

fn key

Executes frequently used system functions when pressed
in coMBination with a function key or the esc key.

(4)

Windows logo key

Displays the Windows Start menu.

(5)

Windows applications key

Displays a shortcut menu for items beneath the pointer.

(6)

Integrated numeric keypad

When the keypad has been enabled, the keys can be used
like an external numeric keypad.

(7)

num lk key

Enables/disables the integrated numeric keypad when
pressed.
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Front

Component

Description

(1)

Supports the following digital card formats:

Media Card reader

●

Secure Digital (SD) Card

●

Secure Digital HC (SDHC) Card

●

Secure Digital XC (SDXC) Card

●

MultiMediaCard (MMC)

●

MultiMediaCardplus (MMC+)

(2)

Display release latch

Opens the computer.

(3)

Wireless light

●

White: An integrated wireless device, such as a wireless
local area network (WLAN) device and/or a Bluetooth®
device, is on.

●

Amber: All wireless devices are off.

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

●

Amber: The computer is connected to external power and
the battery is charged from 0 – 90%.

●

White: The computer is connected to external power and
the battery is charged from 90 – 99%.

●

Blinking Amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

●

Off: The battery is fully charged.

●

Blinking white: The hard drive is being accessed.

●

Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

(4)

(5)

(6)

Power light

AC adapter/Battery light

Hard drive light

NOTE: For information on HP 3D DriveGuard, see the
HP Notebook Reference Guide.
(7)

Speakers (2)

Produce sound.
NOTE: To use the SRS Premium Sound software, select Start
> All Programs > SRS Premium Sound.

Front
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Right

Component
(1)

Description
Audio-out (headphone) jack

Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.
WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety and Environmental Notices.
NOTE: When a device is connected to the headphone
jack, the computer speakers are disabled.

(2)

Audio in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(3)

USB charging port

Connects an optional USB device. The USB 2.0 charging
port can also charge select models of cell phones and MP3
players, even when the computer is off. For more
information about USB devices, see the HP Notebook
Reference Guide.

(4)

USB 2.0 port

Connects optional USB devices.

(5)

External monitor port

Connects an external VGA monitor or projector.

(6)

Smart Card reader

Supports optional Smart Cards.

(7)

Upgrade bay (optical drive shown)

The upgrade bay can hold a weight-saver option, a hard
drive, or an optical drive that reads an optical disc.
NOTE: On select models, the optical drive also writes to
an optical disc.

(8)
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Optical drive eject button
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Releases the disc tray.

Left

Component
(1)

Description
Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2)

USB 3.0 ports (2)

Connect optional USB 3.0 devices and provide enhanced
USB power performance.

(3)

1394 port

Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

(4)

Vents (2)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(5)

RJ-45 (network) jack

Connects a network cable.

(6)

DisplayPort

Connects an optional digital display device, such as a highperformance monitor or projector.

(7)

eSATA/USB 2.0 combo port

Connects a high-performance eSATA component, such as
an eSATA external hard drive, or connects an optional USB
device.

(8)

ExpressCard slot

Supports optional ExpressCards.

Left
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Display

Component

Description

(1)

Turns off the display or initiates Sleep if the display is closed
while the power is on.

Internal display switch

NOTE: The display switch is not visible from the outside of the
computer.
(2)

WLAN antennas (3)*

Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(3)

WWAN antennas (2)* (select models only)

Send and receive wireless signals to communicate with wireless
wide area networks (WWAN).

(4)

Internal microphones (2)

Record sound.

(5)

Webcam light

On: The webcam is in use.

(6)

Webcam

Records video and captures still photographs.
To use the webcam, select Start > All Programs >
Communication and Chat > HP Webcam.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.
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Rear

Component

Description

(1)

RJ-11 (modem) jack

Connects a modem cable.

(2)

Vents (2)

Enable airflow to cool internal components.
NOTE: The computer fan starts up
automatically to cool internal components and
prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(3)

Power connector

Connects an AC adapter.

Rear
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Bottom

Component

Description

(1)

Battery bay

Holds the battery.

(2)

SIM slot

Supports a wireless subscriber identity module (SIM).
The SIM slot is located inside the battery bay.

(3)

Battery release latch

Releases the battery.

(4)

Accessory battery connector

Connects an optional accessory battery.

(5)

Docking connector

Connects an optional docking device.

(6)

Service door release latch

Releases the service door from the computer.

(7)

Vents (3)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(8)
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Bluetooth compartment
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Contains a Bluetooth device (select models only).

Component
(9)

Description
Speakers (2)

Produce sound.
NOTE: To use the SRS Premium Sound software,
select Start > All Programs > SRS Premium Sound.

(10)

Service door

Provides access to the hard drive bay, the wireless
LAN (WLAN) module slot, the WWAN module slot, and
the memory module slots.
NOTE: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the
governmental agency that regulates wireless devices
in your country or region. If you replace the module
and then receive a warning message, remove the
module to restore computer functionality, and then
contact technical support through Help and Support.

Bottom
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Computer major components
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Item

Description

(1)

Display

Spare part number

Display panel, 43.9 cm (17.3 in), High Definition Plus (HD+) Anti-Glare (AG) WVA

691223-001

Display panel, 43.9 cm (17.3 in), FHD AG LED WVA

691224-001

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with webcam
(not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN antenna
and cables, and 2 WWAN antenna and cables)

688736-001

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN
antenna and cables, and 2 WWAN antenna and cables)

688735-001

NOTE: See Display components on page 24 for more display component information and spare part numbers.
(2)

Keyboard (includes keyboard cable, pointing stick and pointing stick cable):
Without backlight, for use in Belgium

688737-A41

With backlight, for use in Belgium

688738–A41

Without backlight, for use in Brazil

688737-201

Without backlight, for use in Canada

688737-DB1

With backlight for use in Canada

688738–DB1

Without backlight, for use in Bulgaria

688737-261

Without backlight, for use in Taiwan

688737-AB1

With backlight, for use in Taiwan

688738-AB1

Without backlight, for use in Denmark

688737-081

With backlight, for use in Denmark

688738-081

Without backlight, for use in Finland and Sweden

688737-B71

With backlight, for use in Finland and Sweden

688738-B71

Without backlight, for use in France

688737-051

With backlight, for use in France

688738-051

Without backlight, for use in Romania

688737–271

Without backlight, for use in Germany

688737-041

With backlight, for use in Germany

688738-041

Without backlight, for use in Czechoslovakia

688737–FL1

With backlight, for use in Czechoslovakia

688738–FL1

Without backlight, for use in Hungary

688737-211

Without backlight, for use in Iceland

688737-DD1

Without backlight, for use in Israel

688737-BB1

Without backlight, for use in Italy

688737-061

With backlight, for use in Italy

688738-061

Without backlight, for use in Japan

688737-291

Computer major components
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Item

Description

Spare part number

Without backlight, for use in Latin America

688737-161

With backlight, for use in Latin America

688738-161

Without backlight, for international use

688737-B31

With backlight, for international use

688738-B31

Without backlight, for use in Northwest Africa

688737-FP1

Without backlight, for use in Norway

688737-091

With backlight, for use in Norway

688738-091

Without backlight, for use in Portugal

688737-131

Without backlight, for use in Russia

688737-251

With backlight, for use in Russia

688738-251

Without backlight, for use in Saudi Arabia

688737-171

Without backlight, for use in Slovenia

688737-BA1

Without backlight, for use in South Korea

688737-AD1

With backlight, for use in South Korea

688738-AD1

Without backlight, for use in Spain

688737-071

Without backlight, for use in Switzerland

688737-BG1

With backlight, for use in Switzerland

688738-BG1

Without backlight, for use in Greece

688737–151

Without backlight, for use in Thailand

688737-281

With backlight, for use in Thailand

688738-281

Without backlight, for use in Turkey

688737-141

Without backlight, for use in the United Kingdom and Singapore

688737-031

With backlight, for use in the United Kingdom and Singapore

688738-031

Without backlight, for use in the United States

688737-001

With backlight, for use in the United States

688738-001

Without backlight for use in India

688737-D61

With backlight for use in India

688738-D61

(3)

Top cover (includes TouchPad)

688747-001

(4)

TouchPad (included with top cover)

(5)

RTC battery

(6)

Fan/graphics board heat sink assembly (includes replacement thermal material):

(7)
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651948-001

For use with AMD graphics subsystem

688733-001

For use with NVIDIA graphics subsystem

696435-001

Primary memory modules (PC3-10600, 1333 MHz, shared):
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Item

(8)

Description

Spare part number

2 GB — 2048 MB memory module (PC3-12800, 1600 MHz, DDR3)

652792-001

4 GB — 4096 MB memory module (PC3-12800, 1600 MHz, DDR3)

641369-001

8 GB — 8192 MB memory module (PC3-12800, 1600 MHz, DDR3)

670034-001

Fan/heat sink assembly (includes replacement thermal material):

653629-001
688762-001

(9)

Processor (includes replacement thermal material):
Next Generation Intel® Core™ processors (support Intel Turbo Boost Technology):
i7-3520M, 2.90 GHz (Turbo up to 3.60 GHz), 1600 MHz, 4 MB L3 Cache, 4 threads, 35W

681954-001

i7-3610QM, 2.30 GHz (Turbo up to 3.30 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W

680646-001

i7-3720QM, 2.60 GHz (Turbo up to 3.60 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W

681283-001

i7-3820QM, 2.70 GHz (Turbo up to 3.70 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 45W

681284-001

i7-3920XM, 2.90 GHz (Turbo up to 3.80 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads,
55W55W

691351-001

Next Generation Intel® Core™ i5 processors (support Intel Turbo Boost Technology):

(10)

(11)

(12)

i5-3320M, 2.60 GHz (Turbo up to 3.30 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W

681952-001

i5-3360M, 2.80 GHz (Turbo up to 3.50 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W

681953-001

Graphics board (includes replacement thermal material):
AMD FirePro M5950 XT-GL 1GB GDDR5 (DP 1.2 and Eyefinity Plus support)

689279-001

NVIDIA Quadro 3000M, N14E-Q1 2 GB dedicated GDDR5 video memory

689280-001

NVIDIA Quadro 4000M, N14E-Q3 2 GB dedicated GDDR5 video memory

689281-001

NVIDIA Quadro 5010M, N14E-Q5 4 GB dedicated GDDR5 video memory

689282-001

Processor heat sink
For use only with computer models equipped with dual-core processors

652542-001

For use only with computer models equipped with quad-core processors

653629-001

Modem module 56K V.92 data/fax modem

628824-001

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part number 652545-001.
(13)

System board (includes replacement thermal material)
For use in all countries and regions except the People's Republic of China:
●

For use with computer models equipped with Intel quad-core processors

688746-001

●

For use with computer models equipped with Intel dual-core processors

688745-001

For use only in the People's Republic of China:

(14)

●

For use with computer models equipped with Intel quad-core processors

690035-001

●

For use with computer models equipped with Intel dual-core processors

690034-001

Expansion memory modules (PC3-10600, 1333 MHz, shared):
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Item

(15)

(16)

(17)

Description

Spare part number

2 GB

652972-001

4 GB

641369-001

8 GB

670034-001

Solid-state drive (includes bracket and screws)
●

256 GB solid-state drive Self-Encrypting drive (SED)

688767-001

●

128 GB solid-state drive

688766-001

●

160 GB solid-state drive

688768-001

●

180 GB solid-state drive

700373-001

WLAN module:
Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module

695915-001

Intel Centrino Ultimate-N 6300, 802.11a/b/g/n WLAN module

698588-001

Broadcom 802.11a/b/g/n 2x2WiFi Adapter

669832-001

WWAN module:
HP un 2430 EV-DO/HSPA Mobile Broadband Module

634400-001

HP hs2340 HSPA+ Mobile Broadband Module

668969-001

(18)

Speaker assembly

652540-001

(19)

Audio/USB 2.0 board

689284-001

(20)

Display (VGA) port

696435-001

(21)

Power connector cable
NOTE: The power connector cable is included in the Cable Kit, spare part number 652545-001.

(22)

Modem cable

628824-001

(23)

Network cable (includes RJ-45 jack)

652545-001

NOTE: The network cable is included in the Cable Kit, spare part number 652545-001.
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(24)

USB 3.0 board

(25)

Battery:

689283-001

9-cell, Li-ion, 2.2 Ah (73 WHr)

634089-001

9-cell, Li-ion, 3.0 Ah (100 WHr)

634087–001

8-cell, Li-ion, 2.8 Ah (75 WHr)

632425-001

8-cell, Li-ion, 2.8 Ah (83 WHr)

632427-001

(26)

Base enclosure (includes computer feet)

688765-001

(27)

ExpressCard (plastic insert)

689283-001

(28)

Mass storage device
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Item

Description

Spare part number

Supports 7.0 mm (0.28 in), 9.5 mm (0.37 in) or 12.7 mm (0.5 in) hard drives and 6.35 cm (2.5 in) solid-state drive for
primary and secondary storage:
NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare part number
642774-001.

(29)

●

750 GB, SATA, 7200-rpm

633252-001

●

500 GB, SATA, 7200-rpm

634925-001

●

320 GB, SATA, 7200-rpm

634862-001

●

500 GB SATA SED (Self-Encrypting Drive), 7200-rpm

683801-001

Optical drive (includes bezel and bracket) supported in upgrade bay
Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

688772-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

688771-001

DVD±RW SuperMulti Double-Layer Drive

688770-001

DVD-ROM Drive

688769-001

Also supported in upgrade bay:

(30)

500 GB, 7200 rpm hard drive

634925-001

Service access cover

698410-001
699467-001 (RCTO)

(31)

Smart Card reader (includes cable)

688742-001

Computer major components
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Item

Description

(1)

Display bezel

Spare part number

Display bezel

688763-001

(2)

Webcam module

688752-001

(3)

Display
Display panel, 43.9 cm (17.3 in), FHD AG WVA

691224-001

Display panel, 43.9 cm (17.3 in), HD+ AG WVA

691223-001
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Item

Description

Spare part number

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN
antenna and cables, and 2 WWAN antenna and cables)

688736–001

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN
antenna and cables, and 2 WWAN antenna and cables)

688735-001

(4)

Display hinge cover

652529-001

(5)

Display Hinge Brackets (included in Display Hinge Kit, left and right hinges and brackets)

652528-001

(6)

WWAN antenna and cables (included in the Antenna Kit, spare part number 652530-001)

(7)

WLAN antenna and cables (included in the Antenna Kit, spare part number 652530-001)

(8)

Display panel cable (includes webcam module cable)

688761-001

(9)

Webcam cable

652527-001

(10)

Display enclosure

652524-001

(11)

Hinge Pipe (included in Display Hinge Kit)

652528-001

Antenna Kit (includes WLAN and WWAN antennas) (not illustrated)

652530-001

Microphone (not illustrated)

655312-001

CRT board (not illustrated)

688741-001

Display components
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Mass storage devices

Item

Description

(1)

7.0 mm (0.28 in), 9.5 mm (0.37 in), or 12.7 mm (0.5 in) hard drive:
NOTE:

26

Spare part number

The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number 642774-001.

●

750 GB, 7200-rpm

633252-001

●

500 GB, 7200-rpm

634925-001

●

320 GB, 7200-rpm

634862-001

●

320 GB, 7200-rpm SATA SED (Self-Encrypting Drive)

683801-001

(2)

Hard drive bracket (Included only with solid-state drives. See spare part numbers below
in this table.)

(3)

Optical drive bracket (Included with optical drive. See spare part numbers below in this
table.)

(4)

Optical drive (includes bezel and bracket)

688769-001

Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

688772-001

DVD±RW SuperMulti Double-Layer Drive

688771-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

688770-001
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Item

(5)

Description

Spare part number

DVD-ROM Drive

688769-001

6.35 cm (2.50 in) Solid-state drive (includes bracket):
●

256 GB solid-state drive Self-Encrypting drive (SED)

688767-001

●

128 GB solid-state drive

688766-001

●

160 GB solid-state drive

688768-001

●

180 GB solid-state drive

700373-001

●

24 GB solid-state drive

701479–001

Mass storage devices
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Miscellaneous parts
Description

Spare part number

AC Adapter
230W PFC Slim AC Smart Adapter

693706-001

200W PFC Slim AC Smart Adapter

693708-001

230W PFC AC Smart Adapter

693714-001

Power cord (3 conductor, black,1.83 m):
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For use in Argentina

491683-D01

For use in Australia

491683-011

For use in Brazil

491683-202

For use in Denmark

491683-081

For use in Europe, the Middle East, and Africa

491683-021

For use in India

491683-D61

For use in Israel

491683-BB1

For use in Saudi Arabia

491683-171

For use in Japan

491683-291

For use in North America

491683-001

For use in the People's Republic of China

491683-AA1

For use in South Africa

491683-AR1

For use in South Korea

491683-AD1

For use in Switzerland

491683-111

For use in Taiwan

491683-AB1

For use in Thailand

491683-201

For use in the United Kingdom and Singapore

491683-031

Hard Drive Hardware Kit (includes hard drive bracket and screws)

642774-001

Hard drive upgrade bay

655547-001

Screw Kit

688744-001

ExpressCard socket

652547-001

Chapter 3 Illustrated parts catalog

Sequential part number listing
Spare part
number

Description

390632-001

Optical USB/PS2, 2 button mouse

434594-001

Optical USB travel mouse

491683-001

Power cord for use in North America (3 conductor, black,1.83 m)

491683-011

Power cord for use in Australia (3 conductor, black,1.83 m)

491683-021

Power cord for use in Europe, the Middle East, and Africa (3 conductor, black,1.83 m)

491683-031

Power cord for use in Singapore and the United Kingdom (3 conductor, black,1.83 m)

491683-081

Power cord for use in Denmark (3 conductor, black,1.83 m)

491683-111

Power cord for use in Switzerland (3 conductor, black,1.83 m)

491683-171

Power cord for use in Saudi Arabia (3 conductor, black,1.83 m)

491683-201

Power cord for use in Thailand (3 conductor, black,1.83 m)

491683-202

Power cord for use in Brazil (3 conductor, black,1.83 m)

491683-291

Power cord for use in Japan (3 conductor, black,1.83 m)

491683-AA1

Power cord for use in the People's Republic of China (3 conductor, black,1.83 m)

491683-AB1

Power cord for use in Taiwan (3 conductor, black,1.83 m)

491683-AD1

Power cord for use in South Korea (3 conductor, black,1.83 m)

491683-AR1

Power cord for use in South Africa (3 conductor, black,1.83 m)

491683-BB1

Power cord for use in Israel (3 conductor, black,1.83 m)

491683-D01

Power cord for use in Argentina (3 conductor, black,1.83 m)

491683-D61

Power cord for use in India (3 conductor, black,1.83 m)

572511-001

WLAN, Intel Centrino Ultimate-N 6300 802.11 a/b/g/n

591699-001

Notebook combination lock

592923–001

Professional Slim Top Load notebook case

626729-002

Keyed cable lock

628824-001

Modem, 56K V.92 data/fax modem

631954-001

WLAN, Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n

632425-001

Battery, 8-cell, Li-ion, 2.8 Ah (75 WHr)

632427-001

Battery, 8-cell, Li-ion, 2.8 Ah (83 WHr)

633252-001

Hard drive, 750GB 7200–RPM SATA

634087-001

Battery, 9-cell, Li-ion, 3.0 Ah (100 WHr)

634089-001

Battery, 9-cell, Li-ion, 2.2 Ah (73 WHr)

634400-001

WWAN, HP un2430 EV-DO/HSPA Mobile Broadband Module

634862-001

Hard drive, 320 GB, 7200-rpm SATA

Sequential part number listing
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Spare part
number

Description

634925-001

Hard drive, 500GB, 7200-rpm SATA

641369-001

Memory module, 4GB (PC3-12800, 1600 MHz)

642774-001

Hard Drive Hardware Kit (includes hard drive bracket and screws)

651948-001

RTC battery

652524-001

Display enclosure

652527-001

Webcam cable

652528-001

Display Hinge Kit (includes left and right hinges, hinge pipe, and brackets)

652529-001

Display hinge covers

652530–001

Antenna Kit (includes WLAN antenna and cables and WWAN antenna and cables)

652532-001

Display Rubber Kit (includes 2 bezel rubber bumpers and 8 rubber screw covers)

652533-001

Display Miscellaneous Kit

652540-001

Speaker assembly

652542-001

Processor heat sink for use only with computer models equipped with dual-core
processors (includes replacement thermal material)

652545-001

Cable Kit (includes DC-jack cable, RJ-45 cable, modem module cable, Bluetooth cable)

652546-001

Smart Card cover

652547-001

ExpressCard socket

652972-001

Memory module, 2 GB (PC3-12800, 1600 MHz)

653629-001

Processor heat sink for use only with computer models equipped with quad-core
processors (includes replacement thermal material)

655312-001

Microphone

655546-001

Plastics Kit (includes optical drive compartment cover, RJ-11 (modem) jack cover, SD
Card cover, and Express Card slot cover)

655547-001

Upgrade bay hard drive

655792-001

Bluetooth module, HP Integrated Module with Bluetooth 4.0+ ENH Data Rate Wireless
Technology
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is included in the Cable Kit, spare part number 652545-001.
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656840-001

Wireless mouse 2.4–GHZ

658265-001

Display Panel Support Kit (includes display enclosure, WLAN antenna cables, WWAN
antenna cables, and webcam cable)

660578-001

Upgrade bay bezel 15/17W

668969-001

WWAN, HP hs2340 HSPA+ Mobile Broadband Module

669832-001

Broadcom 802.11a/b/g/n 2x2WiFi Adapter

670034-001

Memory module, 8 GB (PC3-12800, 1600 MHz)

680646-001

Next Generation Intel® Core™ i7 Processor i7-3610QM, 2.30 GHz (Turbo up to 3.30
GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W
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Spare part
number

Description

681283-001

Next Generation Intel® Core™ i7 Processor, i7–3720QM, 2.60 GHz (Turbo up to 3.60
GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W

681284-001

Next Generation Intel® Core™ i7 Processor, i7-3820QM, 2.70 GHz (Turbo up to 3.70
GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 45W

681952-001

Next Generation Intel® Core™ i5 Processor, i5–3320M, 2.60 GHz (Turbo up to 3.30
GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W

681953-001

Next Generation Intel® Core™ i5 Processor, 5–3360M, 2.80 GHz (Turbo up to 3.50
GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W

681954-001

Next Generation Intel® Core™ i7 Processor, i7-3520M, 2.90 GHz (Turbo up to 3.60
GHz), 1600 MHz, 4 MB L3 Cache, 4 threads, 35W

683801-001

Hard drive, 500 GB, 7200-rpm SATA SED (Self-Encrypting Drive)

688169-001

Docking station/Expansion base

688733-001

Fan/graphics board heat sink assembly for use only with computer models equipped with
AMD graphics subsystems (includes replacement thermal material)

688735-001

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3
WLAN antenna and cables, and 2 WWAN antenna and cables)

688736-001

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3
WLAN antenna and cables, and 2 WWAN antenna and cables)

688737-001

Keyboard without backlight for use in the United States (includes keyboard cable,
pointing stick and pointing stick cable)

688737-031

Keyboard without backlight for use in Singapore and the United Kingdom (includes
keyboard cable, pointing stick and pointing stick cable)

688737-041

Keyboard without backlight for use in Germany (includes keyboard cable, pointing stick
and pointing stick cable)

688737-051

Keyboard without backlight for use in France (includes keyboard cable, pointing stick and
pointing stick cable)

688737-061

Keyboard without backlight for use in Italy (includes keyboard cable, pointing stick and
pointing stick cable)

688737-071

Keyboard without backlight for use in Spain (includes keyboard cable, pointing stick and
pointing stick cable)

688737-081

Keyboard without backlight for use in Denmark (includes keyboard cable, pointing stick
and pointing stick cable)

688737-091

Keyboard without backlight for use in Norway (includes keyboard cable, pointing stick and
pointing stick cable)

688737-131

Keyboard without backlight for use in Portugal (includes keyboard cable, pointing stick
and pointing stick cable)

688737-141

Keyboard without backlight for use in Turkey (includes keyboard cable, pointing stick and
pointing stick cable)

688737-151

Keyboard without backlight for use in Greece (includes keyboard cable, pointing stick and
pointing stick cable)

688737-161

Keyboard without backlight for use in Latin America (includes keyboard cable, pointing
stick and pointing stick cable)

Sequential part number listing
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32

Spare part
number

Description

688737-171

Keyboard without backlight for use in Saudi Arabia (includes keyboard cable, pointing
stick and pointing stick cable)

688737-201

Keyboard without backlight for use in Brazil (includes keyboard cable, pointing stick and
pointing stick cable)

688737-211

Keyboard without backlight for use in Hungary (includes keyboard cable, pointing stick
and pointing stick cable)

688737-251

Keyboard without backlight for use in Russia (includes keyboard cable, pointing stick and
pointing stick cable)

688737-261

Keyboard without backlight for use in Bulgaria (includes keyboard cable, pointing stick
and pointing stick cable)

688737–271

Keyboard without backlight for use in Romania (includes keyboard cable, pointing stick
and pointing stick cable)

688737-281

Keyboard without backlight for use in Thailand (includes keyboard cable, pointing stick
and pointing stick cable)

688737-291

Keyboard without backlight for use in Japan (includes keyboard cable, pointing stick and
pointing stick cable)

688737-A41

Keyboard without backlight for use in Belgium (includes keyboard cable, pointing stick
and pointing stick cable)

688737-AB1

Keyboard without backlight for use in the Czech Republic and Slovakia (includes
keyboard cable, pointing stick and pointing stick cable)

688737-AD1

Keyboard without backlight for use in South Korea (includes keyboard cable, pointing
stick and pointing stick cable)

688737-B31

Keyboard without backlight for international use (includes keyboard cable, pointing stick
and pointing stick cable)

688737-B71

Keyboard without backlight for use in Finland and Sweden (includes keyboard cable,
pointing stick and pointing stick cable)

688737-BA1

Keyboard without backlight for use in Slovenia (includes keyboard cable, pointing stick
and pointing stick cable)

688737-BB1

Keyboard without backlight for use in Israel (includes keyboard cable, pointing stick and
pointing stick cable)

688737-BG1

Keyboard without backlight for use in Switzerland (includes keyboard cable, pointing stick
and pointing stick cable)

688737-D61

Keyboard without backlight for use in India (includes keyboard cable, pointing stick and
pointing stick cable)

688737–DB1

Keyboard without backlight for use in Canada (includes keyboard cable, pointing stick
and pointing stick cable)

688737-DD1

Keyboard without backlight for use in Iceland (includes keyboard cable, pointing stick and
pointing stick cable)

688737-FL1

Keyboard without backlight for use in Czechoslovakia (includes keyboard cable, pointing
stick and pointing stick cable)

688737-FP1

Keyboard without backlight for use in Northwest Africa (includes keyboard cable, pointing
stick and pointing stick cable)

688738-001

Keyboard with backlight for use in the United States (includes keyboard cable, pointing
stick and pointing stick cable)
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Spare part
number

Description

688738-031

Keyboard with backlight for use in the United Kingdom (includes keyboard cable, pointing
stick and pointing stick cable)

688738-041

Keyboard with backlight for use in Germany (includes keyboard cable, pointing stick and
pointing stick cable)

688738-051

Keyboard with backlight for use in France (includes keyboard cable, pointing stick and
pointing stick cable)

688738-061

Keyboard with backlight for use in Italy (includes keyboard cable, pointing stick and
pointing stick cable)

688738-081

Keyboard with backlight for use in Denmark (includes keyboard cable, pointing stick and
pointing stick cable)

688738-091

Keyboard with backlight for use in Norway (includes keyboard cable, pointing stick and
pointing stick cable)

688738-161

Keyboard with backlight for use in Latin America (includes keyboard cable, pointing stick
and pointing stick cable)

688738-251

Keyboard with backlight for use in Russia (includes keyboard cable, pointing stick and
pointing stick cable)

688738-281

Keyboard with backlight for use in Thailand (includes keyboard cable, pointing stick and
pointing stick cable)

688738-A41

Keyboard with backlight for use in Belgium (includes keyboard cable, pointing stick and
pointing stick cable)

688738-AB1

Keyboard with backlight for use in Taiwan (includes keyboard cable, pointing stick and
pointing stick cable)

688738-AD1

Keyboard with backlight for use in South Korea (includes keyboard cable, pointing stick
and pointing stick cable)

688738-B31

Keyboard with backlight for use in Europe (includes keyboard cable, pointing stick and
pointing stick cable)

688738-B71

Keyboard with backlight for use in Finland and Sweden (includes keyboard cable,
pointing stick and pointing stick cable)

688738-BG1

Keyboard with backlight for use in Switzerland (includes keyboard cable, pointing stick
and pointing stick cable)

688738-D61

Keyboard with backlight for use in India (includes keyboard cable, pointing stick and
pointing stick cable)

688738-DB1

Keyboard with backlight for use in Canada (includes keyboard cable, pointing stick and
pointing stick cable)

688738-FL1

Keyboard with backlight for use in Czechoslovakia (includes keyboard cable, pointing
stick and pointing stick cable)

688741-001

CRT board

688742-001

Smart Card (includes cable)

688743-001

Fingerprint reader (includes cable)

688744-001

Screw Kit

688745-001

System board for use with computer models equipped with Intel quad-core processors in
all countries and regions except the People's Republic of China (includes replacement
thermal material)

Sequential part number listing
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Spare part
number

Description

688746-001

System board for use with computer models equipped with Intel quad-core processors in
all countries and regions except the People's Republic of China (includes replacement
thermal material)

688747-001

Top cover (includes TouchPad)

688749-001

Power button board

688752-001

Webcam module with microphone

688760-001

Latch kit (includes door and battery latches)

688761-001

Display panel cable (includes webcam module cable)

688762-001

Fan

688763–001

Display bezel

688765-001

Base enclosure (includes computer feet)

688766-001

128 GB solid-state drive (includes bracket)

688767-001

256 GB solid-state drive (includes bracket)

688768-001

160 GB solid-state drive (includes bracket)

688769-001

DVD-ROM Drive

688770-001

Optical drive, DVD±RW SuperMulti Double-Layer Drive

688771-001

Optical drive, Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

688772-001

Optical drive, Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

689279-001

Graphics board, AMD Firepro M2 XT GL

689280-001

Graphics board, NVIDIA Quadro 3000M, N14E-Q1 2 GB dedicated GDDR5 video
memory

689281-001

Graphics board, NVIDIA Quadro 4000M, N14E-Q3 2 GB dedicated GDDR5 video
memory

689282-001

Graphics board, NVIDIA Quadro 5010M, N14E-Q5 4 GB dedicated GDDR5 video
memory

689283-001

USB 3.0 board (includes cable)

689284-001

Audio/USB 2.0 board

690034-001

System board for use with computer models equipped with Intel quad-core processors in
the People's Republic of China (includes replacement thermal material)

690035-001

System board for use with computer models equipped with Intel quad-core processors in
the People's Republic of China (includes replacement thermal material)

691223-001

Display panel, 43.9 cm (17.3 in), HD+ AG WVA

691224-001

Display panel, 43.9 cm (17.3 in), FHD AG WVA

691351-001

Next Generation Intel® Core i7-3920XM, 2.90 GHz (Turbo up to 3.80 GHz), 1600 MHz, 8
MB L3 Cache, 8 threads, 55W

693706-001

AC adapter, 230 W PFC Slim AC Smart adapter

693708-001

AC adapter, 200 W PFC Slim AC Smart adapter
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Spare part
number

Description

693714-001

AC adapter, 230 W PFC AC Smart adapter

696435-001

Fan/graphics board heat sink assembly, for use only with computer models equipped with
NVIDIA Quadro graphics subsystems (includes replacement thermal material)

696901-001

Application board

698410-001

Service access door

699467-001

Service access door (RCTO)

700373-001

180 GB solid-state drive (includes bracket)

701479-001

24 GB solid-state drive (includes bracket)

Sequential part number listing
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Removal and replacement procedures

Preliminary replacement requirements
Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screwdriver

●

Magnetic screwdriver

●

Phillips P0 and P1 screwdrivers

●

Torx T8 screwdriver

●

5.0 mm hex socket driver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and and pointing stick connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Preliminary replacement requirements
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Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated and pointing stick circuits
provide some protection, but in many cases, ESD contains enough power to alter device parameters
or melt silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and and pointing stick can work
perfectly throughout a normal cycle. Or the device may function normally for a while, then degrade in
the internal layers, reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you area ready to install them.
Use nonmagnetic tools.
Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.
Avoid touching pins, leads, and pointing stick circuitry. Handle electronic components as little as
possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.
CAUTION: A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity
Event
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10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand and pointing stick contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved and pointing stick
containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

●

Use transporters and pointing stick conveyors made of antistatic belts and roller bushings. Be
sure that mechanized equipment used for moving materials is wired to ground and that proper
materials are selected to avoid static charging. When grounding is not possible, use an ionizer to
dissipate electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

●

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

●

Keep the work area free of non conductive materials, such as ordinary plastic assembly aids and
Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid and pointing stick contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.

Preliminary replacement requirements
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground and pointing stick cords.
To provide proper ground, wear a strap snugly against the skin at all times. On grounded mats
with banana-plug connectors, use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground and pointing stick cords of one megohm
resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Non conductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
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Material

Use

Voltage protection level

Antistatic plastic

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.
There are as many as 98 screws and screw locks that must be removed, replaced, or loosened when
servicing the computer. Make special note of each screw and screw lock size and location during
removal and replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
number provided on the service tag.

Item

Component

Description

(1)

Product name

This is the product name affixed to the front of the
computer.

(2)

Serial number (s/n)

This is an alphanumeric identifier that is unique to each
product.

(3)

Part number/Product number (p/n)

This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.

(4)

Warranty period

This number describes the duration of the warranty
period for the computer.

Component replacement procedures
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Computer feet
The computer feet (not illustrated) are adhesive-backed rubber pads. The feet are included in the
base enclosure spare part kit, spare part number 688765-001. The rubber feet that attach to the base
enclosure in the locations illustrated below.

Battery
Description

Spare part number

8-cell, Li-ion 2.8 Ah (75 WHr)

632425-001

8-cell, Li-ion 2.8 Ah (83 WHr)

632427-001

9–cell, Li-ion 3.0 Ah (100 WHr)

634087-001

9–cell, Li-ion 2.2 Ah (73 WHr)

634089-001

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1.

Position the computer upside down on a flat surface, with the front toward you.

2.

Slide the battery release latch to the left (1) to release the battery.

3.

Pivot the battery (2) upward and lift it out of the computer (3).

Install the battery by inserting it into the battery bay until you hear a click.
Before disassembling the computer, follow these steps:
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SIM
Before removing the SIM, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

Remove the SIM:
1.

Press in on the SIM (1) to release it from the SIM slot.

2.

Remove the SIM (2) from the SIM slot.

Install the SIM by inserting it into the SIM slot until you hear a click.

Service access cover
Description

Spare part number

Service access cover

698410-001

Service access cover (RCTO)

699467-001

Before removing the service access cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.
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3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

Remove the service access cover:
1.

Position the computer upside down on a flat surface, with the front toward you.

2.

Slide the service cover release latch to the right (1), and remove the single security screw (2), if
it has been installed.

3.

Slide the service access cover release latch to the right (3) to release the service access cover.

4.

Slide the service access cover toward the front of the computer (4) and then remove the cover
(5).

Reverse this procedure to reassemble and install the service cover. When reinstalling the service
cover, install the security screw in the area that is adjacent to the service cover release latch. The
security screw is located on the service cover.
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Primary hard drive
NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
642774-001.
Description

Spare part number

750 GB, 7200-rpm SATA hard drive

633252-001

500 GB, 7200-rpm SATA hard drive

634925-001

320 GB, 7200-rpm SATA hard drive

638801-001

500 GB, 7200-rpm SATA SED hard drive

634862-001

256 GB solid-state drive (includes bracket and screws)

655027-001

128 GB solid-state drive (includes bracket and screws)

655026-001

24 GB solid-state drive (includes bracket and screws)

701479–001

Before removing the primary hard drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Position the computer with the front toward you.

7.

Loosen the captive screw on the Smart Card reader (1).
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8.

Lift the Smart Card reader to the upright position (2).

9.

Loosen the Phillips M2.5x10.5 captive screws (1) that secure the hard drive to the computer.

10. Grasp the tab on the hard drive and slide the hard drive (2) to disconnect it from the system
board.
11. Lift the left side of the hard drive and remove the hard drive at an angle from the hard drive bay
(3).

12. If it is necessary to remove the hard drive bracket, follow these steps:
a.
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Remove the four Phillips M3.0x3.0 screws (1) that secure the hard drive bracket to the hard
drive.
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b.

Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.

Secondary hard drive
NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
642774-001.
Description

Spare part number

750 GB, 7200-rpm SATA hard drive

633252-001

500 GB, 7200-rpm SATA hard drive

634925-001

320 GB, 7200-rpm SATA hard drive

634862-001

320 GB, 7200-rpm SATA SED hard drive

626978-001

256 GB solid-state drive (includes bracket and screws)

655027-001

128 GB solid-state drive (includes bracket and screws)

655026-001

24 GB solid-state drive (includes bracket and screws)

701479–001

Before removing the secondary hard drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).
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Remove the secondary hard drive:
1.

Position the computer with the front toward you.

2.

Loosen the Phillips M2.5x10.5 captive screws (1) that secure the hard drive to the computer.

3.

Grasp the tab and slide the hard drive (2) to the right. Lift the hard drive up to remove it from the
hard drive bay (3).

4.

If it is necessary to remove the hard drive bracket, follow these steps:
a.

Remove the four Phillips M3.0x3.0 screws (1) that secure the hard drive bracket to the hard
drive.

b.

Lift the bracket (2) straight up to remove it.

Reverse this procedure to reassemble and install the secondary hard drive.
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Smart Card reader
Description

Spare part number

Smart Card reader (with cable)

688742-001

Smart Card reader cover

652546-001

Before removing the Smart Card reader, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Position the computer with the front toward you.

7.

Disconnect the zero insertion force (ZIF) connector (1), lift up the smart card reader until it is
almost vertical (2), and then remove the smart card reader (3).

8.

Remove the Phillips M3.0x2.5 screw (1) that secures the Smart Card reader board to the Smart
Card reader cover.

Component replacement procedures

49

9.

Slide the Smart Card reader back toward the hinges on the Smart Card reader cover, and
remove the Smart Card reader board (2).

Reverse this procedure to reassemble and install the Smart Card reader.

Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 652545-001. See Bluetooth
module cable on page 92 for information on replacing the Bluetooth module cable.
Description

Spare part number

Bluetooth module

655792–001

Before removing the Bluetooth module, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).
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Remove the Bluetooth module:
1.

Remove the Bluetooth module cover.

2.

Gently pry the Bluetooth module away from the adhesive in the base enclosure and lift the
Bluetooth module (1).

3.

Disconnect the Bluetooth module from the Bluetooth cable (2), and remove the module.

Reverse this procedure to install the Bluetooth module.

WLAN module
Description

Spare part number

Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module

695915-001

Component replacement procedures
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Description

Spare part number

Intel Centrino Ultimate-N 6300, 802.11a/b/g/n WLAN module

698588-001

Broadcom 802.11a/b/g/n 2x2WiFi Adapter

669832-001

CAUTION: The WLAN module and the WWAN module are not interchangeable.
To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in
your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.
Before removing the WLAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

Remove the WLAN module:
1.

Position the computer with the front toward you.

2.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The WLAN antenna cables are numbered and connect from left to right on the WLAN
module.

3.

Remove the two Phillips M2.0×2.0 screws (2) that secure the WLAN module to the system
board. (The WLAN module tilts up.)

4.

Remove the WLAN module (3) by pulling the module away from the slot at an angle.
NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion of the
WLAN module into the WLAN module slot.

Reverse this procedure to install the WLAN module.
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WWAN module
Description

Spare part number

HP un2430 EV-DO/HSPA Mobile Broadband Module

634400-001

HP hs2340 HSPA+ Mobile Broadband Module

668969-001

CAUTION: The WWAN module and the WLAN module are not interchangeable.
To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in
your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.
Before removing the WWAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

Remove the WWAN module:
1.

Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.
NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2.

Remove the two Phillips M2.0×2.0 screws (2) that secure the WWAN module to the system
board. (The WWAN module tilts up.)

3.

Remove the WWAN module (3) by pulling the module away from the slot at an angle.

Reverse this procedure to install the WWAN module.
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RTC battery
Description

Spare part number

RTC battery

651948-001

Before removing the RTC battery, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

Remove the RTC battery:
▲

Disconnect the RTC battery cable (1) from the system board and remove the RTC battery (2).
NOTE: You may need to remove some double-sided adhesive.

Reverse this procedure to install the RTC battery.

Optical drive
NOTE: The upgrade bay supports both optical drives and hard drives. If you switch from a hard
drive to an optical drive in the upgrade bay, you will need to remove four additional screws that
secure the hard drive carrier.
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Description

Spare part number

Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

688772-001

DVD±RW SuperMulti Double-Layer Drive

688770-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

688771-001

DVD-ROM Drive

688769-001
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Before removing the optical drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

Remove the optical drive:
1.

Position the computer with the front toward you.

2.

Loosen the Phillips captive screw (1) that secures the optical drive to the computer.

3.

Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.

4.

Remove the optical drive (3).

5.

If it is necessary to replace the optical drive bracket:
a.

Position the optical drive with the rear toward you.

b.

Remove the three Phillips M2.0×3.0 screws (1) that secure the optical drive bracket to the
optical drive.
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c.

6.
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Remove the optical drive bracket (2).

If it is necessary to remove the optical drive bezel:
a.

Insert the end of a paper clip into the release access hole (1) in the optical drive bezel.
Press in gently until the tray is released.

b.

Firmly pull outward on the open tray (2) until the optical drive slides out.
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c.

Firmly pull outward on the bezel to remove the bezel from the optical drive tray.

Reverse this procedure to reassemble and install the optical drive.

Upgrade bay hard drive
NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
642774-001.
Description

Spare part number

7.0 mm, 9.5 mm, or 12.7 mm 500 GB hard drive, 7200 rpm

634925-001

Before removing the upgrade bay hard drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

Remove the upgrade bay hard drive:
1.

Position the computer with the front toward you.
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2.

Remove the four Phillips PM3.0×3.0 screws that secure the upgrade bay hard drive carrier to the
computer.

3.

Loosen the 2 Phillips captive screws (1) that secure the hard drive to the carrier.

4.

Insert a flat-bladed screwdriver or similar tool into the upgrade bay hard drive tab access (2) and
press the tab to the left to release the upgrade bay hard drive from the computer.

5.

Lift and remove the upgrade bay hard drive (3), and then remove the hard disk drive interface
connector (4).

Reverse this procedure to reassemble and install the upgrade bay hard drive and upgrade bay hard
drive carrier.

Primary memory module
NOTE:
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Primary memory is installed under the keyboard.
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A computer having a system board with spare part number 690034-001 or 688745-001 has two
memory slots (primary memory slots). When adding or replacing memory modules, slot 1 must be
populated before slot 2 is populated.
A computer having a system board with spare part number 688746-001 or 690035-001 has four
memory slots (expansion memory slots) (on the bottom of the computer) and the primary memory
slots (under the keyboard). Slot 2 cannot be populated if slot 1 is not populated.
Description

Spare part number

8192 MB memory module (PC3-12800, 1600 MHz, DDR3)

670034-001

4096 MB memory module (PC3-12800, 1600 MHz, DDR3)

641369-001

2048 MB memory module (PC3-12800, 1600 MHz, DDR3)

652972-001

NOTE: A memory module must be installed in the bottom primary memory module slot before a
memory module is installed in the top primary memory module slot.
Before removing a primary memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43)

6.

Remove the hard drive (see Primary hard drive on page 45).

7.

Remove the keyboard (see Keyboard on page 62).

Remove the primary memory module:
1.

Spread the retaining tabs (1) on each side of the primary memory module slot to release the
primary memory module. (The edge of the module opposite the slot rises away from
the computer.)

2.

Remove the primary memory module (2) by pulling the module away from the slot at an angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
primary memory module slots.
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Reverse this procedure to install a primary memory module.

Expansion memory module
NOTE:

Expansion memory slots are located in a compartment on the bottom of the computer.

A computer having a system board with spare part number 690034-001 or 688745-001 has two
memory slots, which are called primary memory slots in this MSG. When you add or replace memory
modules, slot 1 must be populated before slot 2 is populated.
A computer having a system board with spare part number 688746-001 or 690035-001 has four
memory slots. On these computers, in both the expansion memory slots (on the bottom of the
computer) and the primary memory slots (under the keyboard), slot 1 must be populated before slot 2
is populated.
Description

Spare part number

8192 MB memory module (PC3-12800, 1600 MHz, DDR3)

670034-001

4096 MB memory module (PC3-12800, 1600 MHz, DDR3)

641369-001

2048 MB memory module (PC3-12800, 1600 MHz, DDR3)

652972-001

NOTE: A memory module must be installed in the right expansion memory module slot before a
memory module is installed in the left expansion memory module slot.
Before removing an expansion memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

Remove an expansion memory module:
1.
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Spread the retaining tabs (1) on each side of the expansion memory module slot to release the
expansion memory module. (The edge of the module opposite the slot rises away from
the computer.)
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2.

Remove the expansion memory module (2) by pulling the module away from the slot at an
angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
expansion memory module slots.

Reverse this procedure to install an expansion memory module.
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Keyboard
For use in:

Spare part number

For use in:

Spare part number

Keyboard with backlight (includes keyboard cable, pointing stick and pointing stick cable):
Belgium

688738-A41

Norway

688738-091

Denmark

688738-081

Russia

688738–251

Finland and Sweden

688738-B71

France

688738-051

Germany

688738-041

South Korea

688738-AD1

Thailand

688738-281

Switzerland

688738-BG1

International

688738-B31

Taiwan

688738-AB1

The United States

688738-001

The United Kingdom and Singapore

688738-031

Italy

688738-061

Latin America

688738-161

India

688738–D61

Canada

688738–DB1

Czechoslovakia

688738FL1

701977–001

Keyboard without backlight (includes keyboard cable, pointing stick and pointing stick cable):
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Belgium

688737-A41

Greece

688737-151

Brazil

688737-201

Norway

688737-091

Bulgaria

688737-261

Portugal

688737-131

Taiwan

688737-AB1

Russia

688737-251

Denmark

688737-081

Saudi Arabia

688737-171

Finland and Sweden

688737-B71

Slovenia

688737-BA1

France

688737-051

South Korea

688737-AD1

Latin America

688737–161

Spain

688737-071

Germany

688737-041

Switzerland

688737-BG1

Romania

688737–271

Northwest Africa

688737–FP1

Hungary

688737-211

Thailand

688737-281

Iceland

688737-DD1

Turkey

688737-141

International

688737-B31

The United Kingdom and Singapore

688737-031

Israel

688737-BB1

The United States

688737-001

Italy

688737-061

India

688737–D61

Japan

688737-291

Canada

688737–DB1

Czechoslovakia

688737–FL1
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Before removing the keyboard, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

NOTE: The optical drive or hard drive carrier in the upgrade bay must be removed in order to
remove the keyboard.
Remove the keyboard:
1.

Position the computer with the front toward you.

2.

Loosen the three Phillips captive screws that secure the keyboard to the computer.

3.

Position the computer on its side with the display open at a 90 degree angle.

Component replacement procedures

63

4.

Insert a small tool at an angle through the hole in the optical drive bay at an angle to push out
the top edge of the keyboard. This gives you access to the back of the keyboard and releases
the top edge of the keyboard.
NOTE: Make sure that the optical drive or upgrade hard drive have been removed before
performing this procedure.
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5.

Turn the computer right-side up, with the front toward you.

6.

Open the display as far as it will open.

7.

Lift the top edge (1) of the keyboard until it rests at an angle.

8.

Slide the keyboard back toward the display (2).

9.

Release the keyboard ZIF connector (1) and lift the keyboard cable (2) to release it.
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10. Release the pointing stick ZIF connector (3) and lift the cable (4) to release it.

Reverse this procedure to install the keyboard.

Fan/graphics board heat sink assembly
NOTE:

The fan/graphics board heat sink assemblies include replacement thermal material.

Description

Spare part number

For use only with computer models equipped with AMD graphics subsystems

688733-001

For use only with computer models equipped with NVIDIA graphics subsystems

696435-001

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer. The computer uses an electric fan for ventilation. The fan is controlled by a
temperature sensor and is designed to turn on automatically when high temperature conditions exist.
These conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.
Before removing the graphics board heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).
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5.

Remove the service access cover (see Service access cover).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73)

9.

Remove the display assembly (see Display assembly on page 78).

Remove the fan/graphics board heat sink assembly:
NOTE:
cable.
1.
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Before proceeding, make sure you disconnect the power button board cable and the RJ-45

Following the sequence stamped into the graphics board heat sink, loosen the 4 Phillips captive
screws (1) that secure the graphics board heat sink/fan assembly to the system board.

Chapter 4 Removal and replacement procedures

2.

Lift the heat sink/fan assembly (2) straight up to remove it.
NOTE: Due to the adhesive quality of the thermal material located between the fan/graphics
board heat sink assembly and graphics board components, it may be necessary to move the
graphics board heat sink from side to side to detach it from the system board.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the graphics
board heat sink and the graphics board each time the graphics board heat sink is removed:
Thermal paste is used on the largest component (1) on the graphics board and the graphics
board heat sink section (2) that services it.

Reverse this procedure to install the fan/graphics board heat sink assembly.
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Display bezel
Description

Spare part number

Display bezel for use with computer models without a webcam

688763-001

Before removing the display bezel, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the display assembly (see Display assembly on page 78).

Remove the display bezel:
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1.

Remove the screw covers (1), the captive screw (2), and the two screws (3) that secure the
display bezel to the display enclosure.

2.

Remove the screw covers securing the bezel to the display panel (1), and then remove the
screws (2).
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3.

Flex the inside edges of the top edge (3), the left and right sides (4), and the bottom edge (5) of
the display bezel until the bezel disengages from the display enclosure and then remove the
bezel.

Reverse this procedure to install the display bezel.

Display panel
Description

Spare part number

43.9 cm (17.3 in), HD+ AG LED WVA

691223-001

43.9 cm (17.3 in), FHD AG WVA

691224-001

Before removing the display panel, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the display assembly (see Display assembly on page 78).

5.

Remove the display bezel (see Display bezel on page 68).

Remove the display panel:
1.

Remove the 2 Torx screws on each hinge (1).

2.

Remove the two Phillips rawhead screws (2) on the upper left and right corners of the display
panel.
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3.

Remove the 1 Phillips screws (3) that secure the display panel brackets to the hinge pipe.

4.

Slide the hinge pipe to the right (1) and remove the hinge pipe (2).
NOTE: Make sure you pull back the antenna cables when removing the hinge pipe.

5.

Remove the display panel.

Reverse this procedure to reassemble and to install the display panel.
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Display panel cable
Description

Spare part number

Display panel cable (select models only)

688761-001

To remove the display panel cable:
▲

Release the adhesive tape that secures the display panel cable to the display panel (1).
Disconnect the cable (2), and then remove the cable (3).

Hinge brackets
Description

Spare part number

Display hinge brackets kit (consists of the hinge piece and the vertical support brackets for the left
and right sides)

652528-001

To remove the display panel hinge brackets:
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▲

Remove the 4 screws that secure each hinge assembly to the panel (1), and then remove the
hinge brackets (2).

Webcam module
Description

Spare part number

Webcam module with microphone

688752-001

Before removing the webcam module, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the display assembly (see Display assembly on page 78).

5.

Remove the display panel (see Display panel on page 69).
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Remove the webcam module:
1.

Lift the WLAN antenna cables (1), and then remove the WWAN antenna cables (2).

2.

Remove the webcam cable (1) from the hinges and then disconnect the webcam cable from the
display enclosure (2).

3.

Remove the webcam module from the display enclosure (3).

Reverse this procedure to install the webcam module.

Top cover
Description

Spare part number

Top cover (includes TouchPad)

688747-001
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Before removing the top cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

Remove the top cover:
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1.

Position the computer right-side up, with the front toward you.

2.

Remove the 8 Torx M2.5x6.0 screws that secure the base enclosure to the top cover.
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3.

Remove the two Phillips M2.5x3 screws in the optical drive/upgrade drive bay (1) and the four
Phillips M2.5x3.0 screws inside the battery bay (2).

4.

Disconnect the power button board cable (1). Disconnect the TouchPad cable on the left (2) and
the right sides (3).

5.

Disconnect the fingerprint reader cable (4) and then disconnect the application board cable (5).

6.

Position the computer right-side up.
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7.

Grasp the top cover by the hole in the optical disk drive/upgrade drive bay and lift up the front
edge of the top cover (1).

8.

Remove the top cover from the base enclosure (2).

9.

If it is necessary to replace the TouchPad:
a.

Lift the adhesive tape (1), lift and release the TouchPad cable from the opening in top cover
(2), and then release the TouchPad cable (3).

b.

Remove the three screws (1) securing the TouchPad to the top cover.

c.

Release the TouchPad from the front clip (2) securing the TouchPad to the top cover.
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d.

Release the TouchPad from the front right side clip (3) and then remove the TouchPad
from the top cover.

Reverse this procedure to install the top cover and TouchPad.
NOTE: In reversing this procedure, make sure that the display latch assembly actuator lines up
correctly with the top cover to avoid damaging any components.
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Display assembly
Description

Spare part number

Display panel, 43.9 cm (17.3 in), High Definition Plus (HD+) Anti-Glare (AG) LED WVA without
webcam

691223-001

Display panel, 43.9 cm (17.3 in), FHD AG LED WVA

691224-001

43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with webcam (not available with HP
Mobile Broadband)

688736-001

43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without webcam (not available with HP
Mobile Broadband)

688735-001

Display Hinge Kit

652528-001

Display hinge covers

652529-001

Before removing the display assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

Remove the display assembly:
1.

78

Position the computer upside down.
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2.

Remove the tape (1) that secures the WLAN and WWAN cables to the system board. (2).

3.

Turn the computer right side up, facing you. Feed the WLAN and WWAN cables through the
hole next to the keyboard screw (1), and then lift the cable free of the routing areas (2).
Disconnect the webcam cable (3).

4.

Position the computer with the rear towards you.
CAUTION: Support the display assembly when removing the display screws in the following
steps. Failure to support the display assembly can result in damage to the assembly and other
components.
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5.

Disconnect the display panel cable (1), and then remove the cable (2).
NOTE: Make sure all cables are freed from the clips in the routing channel.

6.
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Turn the unit around, and then remove the Torx M2.5x7.0 screws (1) that secure the display
hinges to the base enclosure. Next, remove the Torx M2.5x3.0 screws (2) that secure the hinge
cover to the base enclosure. Remove the four 8 millimeter Torx screws (3) that secure the hinge
cover to the base enclosure.
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7.

Position the computer with the rear toward you. Lift the rear hinges and remove.

8.

Remove the two 6 millimeter Torx screws securing the display panel to the base enclosure (1)`,
and then remove the display panel (2).

Reverse this procedure to reassemble and to install the display assembly.

Power button board
Description

Spare part number

Power button board

688749-001
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Before removing the power button board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42)

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

Remove the power button board:
1.

Position the top cover upside down with the front toward you.

2.

Slide the power button board cable out from the clips in the top cover (1).

3.

Remove the conductive tape (2) that secures the power button board cable to the top cover.

4.

Remove the two Phillips M2.5x3.0 screws (3) that secure the power button board to the top
cover, and then remove the power button board (4).

Reverse this procedure to install the power button board.

Application button board
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Description

Spare part number

Application button board

696901-001
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Before removing the application button board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

Remove the application button board:
1.

Position the top cover upside down with the front toward you.

2.

Slide the application button board cable (1) out from the clip in the top cover.

3.

Remove the two Phillips M2.5x3.0 screws (2) that secure the application button board to the top
cover.

4.

Remove the application button board (3).

Reverse this procedure to install the application button board.

Fingerprint reader
Description

Spare part number

Fingerprint reader

688743-001
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Before removing the fingerprint reader, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42)

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

Remove the fingerprint reader:
1.

Position the top cover upside down with the front toward you.

2.

Slide the fingerprint reader cable (1) out from the 3 clips in the top cover and remove it.

3.

Peel off the tape (2) that secures the fingerprint reader to the top cover.

4.

Lift the fingerprint reader (3) from the top cover.

Reverse this procedure to install the fingerprint reader.

Audio/USB 2.0 board
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Description

Spare part number

Audio/USB 2.0 board

689284-001

Chapter 4 Removal and replacement procedures

Before removing the Audio/USB 2.0 board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42),

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

Remove the audio/USB 2.0 board:
1.

Position the computer right-side up with the front toward you.

2.

Remove the three Phillips M2.5x3.0 screws (1) that secure the audio/USB 2.0 board to the base
enclosure.

3.

Disconnect the speaker cable (2) from the Audio/USB 2.0 board.

4.

Lift the left edge of the audio/USB 2.0 board to disconnect it from the system board and remove
the audio/USB 2.0 board (3) at an angle to the left from the base enclosure

Reverse this procedure to install the audio/USB 2.0 board.
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Speaker assembly
Description

Spare part number

Speaker assembly

652540-001

Before removing the speaker assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the Smart Card reader (see Smart Card reader on page 49).

10. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 84).
Remove the speaker assembly:
1.
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Remove the two Phillips M2.5x6.0 screws (1) that secure the speaker assembly to the base
enclosure.
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2.

Gently flex the band on the base enclosure next to the speaker assembly, and remove the
speaker assembly (2).

Reverse this procedure to install the speaker assembly.

Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 652545-001. See Modem module cable
on page 90 for information on replacing the modem module cable.
Description

Spare part number

56K V.92 1 data/fax modem

628824-001

Before removing the modem module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).
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6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the Smart Card reader (see Smart Card reader on page 49).

10. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 84).
Remove the modem module:
1.

Position the computer right-side up with the front toward you.

2.

Remove the two Phillips M2.0x3.0 screws (1) that secure the modem to the system board.

3.

Lift the modem upwards (2).

4.

Disconnect the modem cable (3) from the modem.

Reverse this procedure to install the modem module.

Display (VGA) port
Before removing the modem module cable, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).
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7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the Smart Card reader (see Smart Card reader on page 49).

10. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 84).
Remove the VGA port:
▲

Remove the Phillips screw (1) that secures the display (VGA) port to the base enclosure. Lift the
port (2) up at an angle to remove it.
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Modem module cable
NOTE:

The modem module cable is included in the Cable Kit, spare part number 652545-001.

Before removing the modem module cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the Smart Card reader (see Smart Card reader on page 49).

10. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 84).
11. Remove the modem module (see Modem module on page 87).
Remove the modem module cable:
1.

Position the computer right side-up with the front toward you.

2.

Remove the modem cable from the routing clips in the base enclosure.

3.

Loosen the Torx M2.0x3.0 screw from the side black trim piece (1).

4.

Gently pry the modem module cable out from the base enclosure (2), and then remove cable (3).

Reverse this procedure to install the modem module cable.
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Card reader/USB 3.0 board
Description

Spare part number

Card reader/USB 3.0 board

689283-001

Before removing the card reader/USB 3.0 board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

Remove the card reader/USB 3.0 board:
1.

Position the computer right-side up with the front toward you.

2.

Remove any plastic blanks in the card reader slots.

3.

Remove the 3 Phillips M2.5x3.0 screws (1) that secure the card reader/USB 3.0 board to the
base enclosure.

4.

Lift the left side (2) of the card reader/USB 3.0 board to disconnect it from the system board.

Reverse this procedure to install the card reader/USB 3.0 board.
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Bluetooth module cable
NOTE:

The Bluetooth module cable is included in the Cable Kit, spare part number 652545-001.

Before removing the Bluetooth module cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the bluetooth module (see Bluetooth module on page 50).

10. Remove the card reader/USB 3.0 board (see Card reader/USB 3.0 board on page 91).
Remove the Bluetooth module cable:
1.

Position the computer right-side up with the front toward you.

2.

Disconnect the Bluetooth cable (1) from the system board.

3.

Remove the Bluetooth cable (2).

Reverse this procedure to install the Bluetooth module cable.

System board
NOTE:
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All system board spare part kits include replacement thermal material.
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NOTE: Models that support quad-core processors have four memory slots. Models that support
dual-core processors have two memory slots.
Description

Spare part number

For use in all countries and regions except the People's Republic of China:
●

For use with computer models equipped with Intel quad-core processors

688746-001

●

For use with computer models equipped with Intel dual-core processors

688745-001

For use only in the People's Republic of China:
●

For use with computer models equipped with Intel quad-core processors

690035-001

●

For use with computer models equipped with Intel dual-core processors

690034-001

Before removing the system board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the display assembly (see Display assembly on page 78).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 65).
11. Remove the processor heat sink (see Processor heat sink on page 99).
12. Remove the audio/USB 2.0 board (see Audio/USB 2.0 board on page 84).
13. Remove the speaker assembly (see Speaker assembly on page 86).
14. Remove the Card reader/USB 3.0 board (see Card reader/USB 3.0 board on page 91).
When replacing the system board, be sure that the following additional components are removed
from the defective system board and installed on the replacement system board:
●

SIM (see SIM on page 43)

●

Bluetooth module and cable (see Bluetooth module on page 50 and Bluetooth module cable
on page 92)

●

WLAN module (see WLAN module on page 51)

●

WWAN module (see WWAN module on page 53)

●

RTC battery (see RTC battery on page 54)
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●

Primary memory modules (see Primary memory module on page 58)

●

Expansion memory modules (see Expansion memory module on page 60)

●

Graphics board (see Graphics board on page 104)

●

Processor heat sink (see Processor heat sink on page 99)

●

Processor (see Processor on page 101)

●

Modem module (see Modem module on page 87)

Remove the system board:
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1.

Disconnect the power connector cable (1) from the system board.

2.

Disconnect the network cable (2) from the system board.

3.

Remove the 2 captive screws securing the fan (1).
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4.

Remove the 4 Phillips M2.5x3.0 screws (marked with a triangle icon) that secure the system
board to the base enclosure (2), and then remove the short stand off screw (3) and the tall stand
off screw (4).

5.

Lift up on the right side of the system board (1), and then remove the system board (2) by sliding
it out.

Reverse this procedure to install the system board.
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Network cable and jack
NOTE:

The network cable is included in the Cable Kit, spare part number 652545-001.

Before removing the network cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the display assembly (see Display assembly on page 78).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 65).
11. Remove the processor heat sink (see Processor heat sink on page 99).
Remove the network cable:
▲

Remove the network cable from the sideband on the base enclosure.

Reverse this procedure to install the network cable.

Power connector cable
The power connector cable is included in the Cable Kit, spare part number 652545-001.
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Before removing the power connector cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the display assembly (see Display assembly on page 78).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 65).
11. Remove the processor heat sink (see Processor heat sink on page 99).
Remove the power connector cable:
▲

Remove the power connector cable jack from the base enclosure.

Reverse this procedure to install the Power connector cable.

Security lock
The security lock is included with the base enclosure assembly, spare part number 652535-001.
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Before removing the security lock, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the display assembly (see Display assembly on page 78).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 65).
11. Remove the processor heat sink (see Processor heat sink on page 99).
12. Remove the audio/USB 2.0 board (see Audio/USB 2.0 board on page 84).
13. Remove the speaker assembly (see Speaker assembly on page 86).
14. Remove the Card reader/USB 3.0 board (see Card reader/USB 3.0 board on page 91).
15. Remove the system board (see System board on page 92).
Remove the security lock:
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1.

Position the computer right-side up with the front toward you.

2.

Remove the Torx T9M2.5×6.0 screw (1) that secures the security lock to the base enclosure.
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3.

Rotate the security lock away from the base enclosure and remove the security lock from the
base enclosure (2).

Reverse this procedure to install the security lock.

Processor heat sink
Description

Spare part number

For use only with computer models equipped with quad-core processors

653629-001

For use only with computer models equipped with dual-core processors

652542-001

Before removing the processor heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42)

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 65).
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Remove the processor heat sink:
1.

Following the sequence stamped into the processor heat sink, loosen the four Phillips captive
screws (1) that secure the processor heat sink to the system board.
NOTE: Due to the adhesive quality of the thermal material located between the processor heat
sink and the processor, it may be necessary to move the processor heat sink from side to side to
detach it from the system board.

2.

Lift the processor heat sink up and to the right at an angle and remove it from the base
enclosure (2).

NOTE: Thermal paste located on the surfaces of the processor (1) and the processor heat sink
(2) must be thoroughly removed and replaced each time the processor heat sink is removed.
Replacement thermal paste is included in the processor heat sink and processor spare part kits.

Reverse this procedure to install the processor heat sink.
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Processor
NOTE:

The processor spare part kit includes replacement thermal material.

Description

Spare part number

Next Generation Intel® Core™ processors, (support Intel Turbo Boost Technology) (includes replacement thermal
material):
i7-3610QM, 2.30 GHz (Turbo up to 3.30 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W

680646-001

i7-3720QM, 2.60 GHz (Turbo up to 3.60 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 45W

681283-001

i7-3820QM, 2.70 GHz (Turbo up to 3.70 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 45W

681284-001

i7-3520M, 2.90 GHz (Turbo up to 3.60 GHz), 1600 MHz, 4 MB L3 Cache, 4 threads, 35W

681954-001

i7-3920XM, 2.90 GHz (Turbo up to 3.80 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 55W

691351-001

Next Generation Intel® Core™ i5 processors, (support Intel Turbo Boost Technology) (includes
replacement thermal material):
i5-3360M, 2.80 GHz (Turbo up to 3.50 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W

681953-001

i5-3320M, 2.60 GHz (Turbo up to 3.30 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 35W

681952-001

Before removing the processor, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42)

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 65).

10. Remove the processor heat sink (see Processor heat sink on page 99).
Remove the processor:
1.

Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise, until you hear a click.
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2.

Lift the processor (2) straight up and remove it.
NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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Fan/Heat sink
▲

Remove the 4 screws securing the fan/heat sink (1), and then remove the fan/heat sink (2).
NOTE: Make sure the fan cable is disconnected from the system board.

NOTE: This diagram shows a view of of the processor (1) the paste (2), the board components
(3), and the pads (4). Thermal paste must be thoroughly removed and replaced each time the
processor heat sink is removed. Replacement thermal paste is included in the processor heat
sink and processor spare part kits.
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Graphics board
NOTE:

The graphics board spare part kit includes replacement thermal material.

Description

Spare part number

AMD FirePro M5950 XT-GL 1GB GDDR5 (DP 1.2 and Eyefinity Plus support)

689279-001

NVIDIA Quadro 5010M, N14E-Q5 4 GB dedicated GDDR5 video memory

689282-001

NVIDIA Quadro 4000M, N14E-Q3 2 GB dedicated GDDR5 video memory

689281-001

NVIDIA Quadro 3000M, N14E-Q1 2 GB dedicated GDDR5 video memory

689280-001

Before removing the graphics board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42),

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 65).

Remove the graphics board:
1.

Remove the 2 Phillips M2.5×3.0 screws (1) that secure the graphics board to the system board.
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2.

Lift the right edge of the graphics board until it rests at an angle and remove (2).

Reverse this procedure to install the graphics board.

Fan
Description

Spare part number

Fan

688762-001

Before removing the fan, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 42).

5.

Remove the service access cover (see Service access cover on page 43).

6.

Remove the optical drive (see Optical drive on page 54) or upgrade bay hard drive (see Upgrade
bay hard drive on page 57).

7.

Remove the keyboard (see Keyboard on page 62).

8.

Remove the top cover (see Top cover on page 73).

9.

Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 65).

Remove the fan from the fan/graphics board heat sink assembly:
1.

Remove the 3 Phillips PM2.0×3.0 screws (1) that secure the fan to the fan/graphics board heat
sink assembly.
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2.

Remove the fan (2).

Reverse this procedure to install the fan into the fan/graphics board heat sink assembly.
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5

Computer Setup (BIOS) and Advanced
System Diagnostics
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

Using Computer Setup
Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2.

Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
– or –

●

To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup
NOTE:

Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select File > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the
factory settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:
1.

Start Computer Setup.

2.

Use a pointing device or the arrow keys to select File > System Information.

3.

To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of
the screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.
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Downloading a BIOS update
CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful
installation, download and install a BIOS update only when the computer is connected to reliable
external power using the AC adapter. Do not download or install a BIOS update while the computer is
running on battery power, docked in an optional docking device, or connected to an optional power
source. During the download and installation, follow these instructions:
Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Suspend or Hibernation.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

Open your Web browser. For U.S. support, go to http://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2.

Follow the on-screen instructions to identify your computer and access the BIOS update you
want to download.

3.

Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer
and access the BIOS update you want to download.

4.

Click your specific product from the models listed.

5.

Click the appropriate operating system.

6.

Go to the BIOS section and download the BIOS software package.

7.

Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer
hardware is functioning properly. The following diagnostic tests are available in Advanced System
Diagnostics:
●

Start-up test—This test analyzes the main computer components that are required to start
the computer.

●

Run-in test—This test repeats the start-up test and checks for intermittent problems that the
start-up test does not detect.

●

Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

●

Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

●

Battery test—This test analyzes the condition of the battery and calibrates the battery if
necessary. If the battery fails the test, contact support to report the issue and purchase a
replacement battery.

●

System Tune-Up—This group of additional tests checks your computer to make sure that the
main components are functioning correctly. System Tune-Up runs longer and more
comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface,
the battery (and battery calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.
To start Advanced System Diagnostics:
1.

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2.

Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE:

If you need to stop a diagnostics test while it is running, press esc.
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Specifications

Computer specifications
Metric

U.S.

Width

41.70 cm

16.40 in

Depth

27.20 cm

10.70 in

Height (front to back)

3.70 cm to 4.30 cm

1.47 in to 1.68 in

Weight

3.60 kg

7.96 lbs

Dimensions

Input power
Operating voltage

19.5 V dc @ 4.74 A – 120 W

Operating current

4.74 A

Temperature
Operating

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Operating

10% to 90%

10% to 90%

Nonoperating

5% to 95%

5% to 95%

Operating

-15 m to 3,048 m

-50 ft to 10,000 ft

Nonoperating

-15 m to 12,192 m

-50 ft to 40,000 ft

Relative humidity (noncondensing)

Maximum altitude (unpressurized)

Shock
Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration
Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.
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43.9 cm (17.3 in) WVA display specifications
Metric

U.S.

Width

24.4 cm

9.65 in

Depth

38.1 cm

15.0 in

Diagonal

43.9 cm

17.3 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

180 nits (typical)

Backlight

LED

Character display

80 × 25

Total power consumption

6.0 W

Viewing angle

+/-65 horizontal, +/-50° vertical (typical)

Dimensions

Hard drive specifications
750 GB*

500 GB*

320 GB*

Height

9.5 mm

9.5 mm

9.5 mm

Width

7.0 mm

7.0 mm

7.0 mm

Weight

101 g

101 g

101 g

Interface type

SATA

SATA

SATA

Transfer rate

100 MB/sec

100 MB/sec

100 MB/sec

Security

ATA security

ATA security

ATA security

Single track

3 ms

3 ms

3 ms

Average

13 ms

13 ms

13 ms

Maximum

24 ms

24 ms

24 ms

Logical blocks

1,250,242,867

976,752,240

625,121.433

Disk rotational speed

7200 rpm

7200 rpm

7200 rpm

Dimensions

Seek times (typical read, including setting)

Operating temperature

5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.
NOTE: Certain restrictions and exclusions apply. Contact technical support for details.

43.9 cm (17.3 in) WVA display specifications 113

Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive
specifications
Applicable disc

Read:

Write:

BD-ROM, BD-ROM-DL, BD-R, BD-RDL, BD-RE, BD-RE-DL, DVD-ROM,
DVD+R, DVD+R-DL, DVD+RW, DVDR, DVD-R-DL, DVD-RW, DVD-RAM
(Ver.2), CD-DA, CD-ROM (mode 1 and
mode 2), CD-ROM XA (mode 2, form 1
and form 2), Photo CD (single and
multiple sessions), CD Extra, CD-R,
CD-RW, and CD-TEXT

DVD-RAM (Ver.2), DVD+R, DVD-R,
CD-R, and CD-ROM

Access time

BD

DVD

Random

< 230 ms

< 180 ms

Cache buffer

4.5 MB

Data transfer rate
2X BD-RAM

9 MB/sec

8X DVD

2,400 KB/sec

16X CD-R

2,400 KB/sec

16X CD-RW

2,400 KB/sec

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive
specifications
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CDTEXT,
CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio,
CD-R, CD-RW), CD-R, CD-RW,
DVDROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HDROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9),DVD-RW,
DVD-RAM

Access time

CD

DVD

HD

Random

170 ms

170 ms

230 ms

Cache buffer

8 MB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

10,800 KB/sec
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Applicable disc

Read:

Write:

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

1X BD-ROM

4,500 KB/sec

1X BD-R read

4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode

DVD±RW SuperMulti Double-Layer Drive specifications
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD mIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo cD, Video
CD), Multisession CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CDRW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW

Access time

CD

DVD

Random

< 175 ms

< 230 ms

Cache buffer

2.5 MB

DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec
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Applicable disc

Read:

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode

Write:

DVD-ROM Drive specifications
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD mIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo cD,
Video CD), Multisession CD (Photo cD,
CDEXTRA, Portfolio, CD-R, CD-RW),
CDR, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R,
DVD-RW, DVD+R, DVD+RW, DVDRAM

CD-R and CD-RW

Access time

CD

DVD

Random

< 110 ms

< 130 ms

Cache buffer

2 MB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

3,600 KB/sec
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Backup and recovery
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only)
with the installed optical drive (select models only) or an optional external optical drive, or create
system restore points. In case of system failure, you can use the backup files to restore the contents
of your computer.
Windows Backup and Restore provides the following options:
●

Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

●

Backing up your information

●

Creating a system image (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

Recovering information using recovery tools

NOTE:

For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them
for later use.
NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery Disc Creator
HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP
Recovery Disc Creator. This recovery media allows you to reinstall your original operating system as
well as select drivers and applications if the hard drive becomes corrupted.
HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:
●

Windows DVD—Installs the operating system without additional drivers or applications.

●

Driver DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

Creating recovery media
NOTE: The Windows DVD can be created only once. Thereafter, the option to create that media will
not be available.
1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Driver DVD or Windows DVD.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Burn button to start the burning process.

Backing up your information
Recovery after a system failure is as good as your most recent backup. Immediately after setting up
the computer, you should create system repair discs (select models only) using the installed optical
drive (select models only) or an optional external optical drive and back up your system. As you add
new software and data files, you should continue to back up your system on a regular basis to
maintain a reasonably current backup. The system repair discs (select models only) are used to start
up (boot) the computer and repair the operating system in case of system instability or failure. Your
initial and subsequent backups allow you to restore your data and settings if a failure occurs.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

●

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive you are using.
NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

●

When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:
NOTE:

Be sure that the computer is connected to AC power before you start the backup process.
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NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, see the
Using a Windows 7 operating system DVD (purchased separately) section.

Using the Windows recovery tools
To recover information you previously backed up:
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:
CAUTION: Some Startup Repair options completely erase hard drive contents and reformat the
hard drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition.
To check for the Windows partition, select Start > Computer.

3.

If the Windows partition is listed, restart the computer, and then press f8 before the Windows
operating system loads.

4.

Select Startup Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11 recovery tools
CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: click Start, right-click
Computer, click Manage, and then click Disk Management.
NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see the Using a Windows 7
operating system DVD (purchased separately) section.

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11>” for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)
To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http:// www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the
Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 7 operating system DVD:
NOTE:

This process takes several minutes.

1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.

After the repair is completed:
1.

Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Power cord set requirements
The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.
The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:
●

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions
Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

COC

5

South Korea

EK

4
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Country/region

Accredited agency

Applicable note number

Sweden

SEMKO

1

Switzerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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Recycling
When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not
dispose of the battery in general household waste. Follow the local laws and regulations in your area
for battery disposal.
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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Index
Symbols/Numerics
1394 port, identifying

13

A
AC adapter, spare part numbers
28, 34, 35
accessory battery connector,
identifying 16
Antenna Kit
spare part number 25, 30
application button board
removal 82
spare part number 82
audio in (microphone) jack 12
audio, product description 2
audio-out (headphone) jack 12
audio/USB 2.0 board
removal 84
spare part number 22, 34, 84
B
base enclosure
spare part number 22, 34
battery
removal 42
spare part numbers 22, 29, 42
battery bay, identifying 16
battery light 11
battery release latch 16
bezel, upgrade bay
30
Blu-ray Disc ROM with SuperMulti
DVD±R/RW DL Drive
specifications 114
Blu-ray R/RE DVD±RW SuperMulti
Double-Layer Drive
precautions 37
spare part number 23, 26, 34,
54
specifications 114
Blu-ray ROM DVD±RW SuperMulti
Double-Layer Drive
spare part number 23, 26, 34,
54

Bluetooth module
removal 50
spare part number 30, 50
Bluetooth module cable
removal 92
Bluetooth module compartment
cover
removal 51
board, application
spare part numbers 35
buttons
calculator 9
center TouchPad 7
left TouchPad 7
optical drive eject 12
pointing stick 7
power 9
right TouchPad 7
TouchPad 7, 9
volume mute 9
wireless 9
C
Cable Kit
spare part number 30
cables, service considerations 37
calculator button, identifying 9
calculator light 8
caps lock light, identifying 8
card reader/USB 3.0 board
removal 91
spare part number 91
case, notebook slim top load
spare part number 29
chipset, product description 1
components
bottom 16
display 14
front 11
left side 13
rear 15
right side 12
top 7
computer feet, locations 42
computer part number 41

computer specifications 112
connector, power 15
connector, service
considerations 37
CRT board
spare part number 25, 33
D
diskette drive
precautions 37
display assembly
removal 78
spare part numbers 19, 31, 78
display bezel
removal 68
spare part number 34
spare part numbers 24, 68
display enclosure
spare part number 25, 30
display hinge covers
spare part number 30
Display Hinge Kit, spare part
number 25, 30
Display Miscellaneous Kit, spare
part number 30
display panel
product description 1
removal 69
spare part number 30, 34, 69
display panel cable
spare part number 25, 34
display release latch 11
Display Rubber Kit
spare part number 30
display specifications 113
DisplayPort, identifying 13
docking connector, identifying 16
docking station
spare part numbers 31
docking support, product
description 4
drives, preventing damage 37
DVD-ROM Drive
precautions 37
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spare part number 23, 27, 34,
54
specifications 116
DVD±RW and CD-RW SuperMulti
Double-Layer combo Drive
precautions 37
specifications 115
DVD±RW SuperMulti DoubleLayer Drive
spare part number 23, 26, 34,
54
specifications 115
E
electrostatic discharge 38
eSATA port, identifying 13
esc key, identifying 10
Ethernet, product description 3
ExpressCard slot
identifying 13
spare part number 28
ExpressCard socket
spare part number 30
external media cards, product
description 3
external monitor port 12
F
fan
removal 105
spare part number 34, 105
fan/graphics board heat sink
assembly
removal 65
spare part number 20, 21
spare part numbers 31, 35, 65
feet, locations 42
Fingerprint reader
spare part numbers 33
fingerprint reader
identifying 9
removal 83
spare part number 83
fn key, identifying 10
function keys
identifying 10

G
graphics board
removal 104
spare part numbers 21, 34,
104
graphics, product description 1
grounding equipment and
methods 40
H
hard drive
precautions 37
product description 2
removal 45, 47
spare part numbers 23, 26,
29, 30, 31, 45, 47
specifications 113
hard drive cover
removal 46
Hard Drive Hardware Kit
spare part number 28, 30
hard drive upgrade bay
spare part number 28
heat sink
spare part numbers 30
hinge
spare part number 25, 30
hinge cover
illustrated 25
I
integrated numeric keypad,
identifying 10
integrated webcam light,
identifying 14
internal display switch 14
internal microphones, identifying
14
J
jacks
audio in (microphone) 12
audio-out (headphone) 12
network 13
RJ-11 (modem) 15
RJ-45 (network) 13
K
keyboard
product description 4
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removal 62
spare part numbers 19, 31,
32, 33, 62
keypad, integrated numeric 10
keys
esc 10
fn 10
function 10
num lk 10
Windows applications 10
Windows logo 10
L
latch kit
spare part number 34
latches, battery release 16
latches, service door release
lights
battery 11
calculator 8
caps lock 8
mute 8
num lock 8
power 8, 11
TouchPad 8
Web browser light 8
webcam 14
wireless 8, 11
lock, keyed cable
spare part number 29
lock, notebook combination
spare part number 29

16

M
mass storage device
spare part numbers 26
mass storage device, spare part
numbers 22
Media Card reader, identifying 11
memory module
product description 1
removal 58, 60
spare part number 30
spare part numbers 20, 21,
30, 58, 60
microphone
product description 2
spare part number 25, 30
miscellaneous parts
spare part numbers 28

model name 1
modem module
product description 3
removal 87
spare part number 21, 29, 87
modem module cable
removal 90
mouse, optical 2 button
spare part number 29
mouse, travel
spare part number 29
mouse, wireless
spare part number 30
mute light, identifying 8
N
network cable
removal 96
spare part number 22
network jack, identifying 13
num lk key, identifying 10
num lock light 8
O
operating system, product
description 5
optical drive
identifying 12
precautions 37
product description 2
removal 54
spare part number 34
spare part numbers 23, 26, 54
specifications 114, 115, 116
optical drive bracket
spare part number 26
optical drive eject button,
identifying 12
P
packing guidelines 39
plastic parts 36
Plastics Kit
spare part number 30
pointing device
product description 4
pointing stick 7
pointing stick buttons 7
ports
1394 13
DisplayPort 13

eSATA 13
eSATA/USB 2.0 combo 13
external monitor 12
product description 4
USB 2.0 12, 13
USB charging 12
power button board
removal 81
spare part number 34, 81
power button, identifying 9
power connector cable
removal 96
spare part number 22
power connector, identifying 15
power cord
set requirements 122
spare part numbers 28, 29
power light 8, 11
power requirements, product
description 4
processor
product description 1
removal 101
spare part number 30
spare part numbers 21, 31,
34, 101
processor heat sink
removal 99
spare part number 30
spare part numbers 99
processor heat sink, spare part
numbers 21
processor,
spare pare numbers 31
product description
audio 2
chipset 1
display panel 1
docking support 4
Ethernet 3
external media cards 3
graphics 1
hard drives 2
keyboard 4
memory module 1
microphone 2
modem module 3
operating system 5
optical drives 2
pointing devices 4

ports 4
power requirements 4
processors 1
product name 1
security 5
serviceability 6
solid state drive 2
video 2
wireless 3
product name 1, 41
product number 41
R
removal/replacement
preliminaries 36
procedures 41
RJ-11 (modem) jack, identifying
15
rj-11 modem cable
spare part numbers 22
RJ-45 (network) jack, identifying
13
RTC battery
removal 54
spare part number 20, 30, 54
S
Screw Kit
spare part number 28, 33
security cable slot, identifying 13
security lock
removal 97
security, product description 5
sequential part numbers 29
serial number 41
service access cover
removal 43
spare part number 23, 43
service access door
spare part numbers 35
service considerations 36
service door release latch 16
service tag 41
serviceability, product
description 6
SIM slot, identifying 16
SIM, removal 43
slots
ExpressCard 13

Index 127

security cable 13
SIM 16
Smart Card
spare part number 33
Smart Card cover
spare part number 30
Smart Card reader
removal 49
spare part number 23, 49
solid-state drive
precautions 37
product description 2
spare part numbers 22, 27,
34, 35
speaker assembly
removal 86
spare part number 30, 86
speakers, identifying 11
specifications
Blu-ray Disc ROM with
SuperMulti DVD±R/RW DL
Drive 114
Blu-ray R/RE DVD±RW
SuperMulti Double-Layer
Drive 114
computer 112
display 113
DVD-ROM Drive 116
DVD±RW SuperMulti DoubleLayer Drive 115
hard drive 113
optical drive 114, 115, 116
static-shielding materials 40
system board
removal 92
spare part number 33
spare part numbers 21, 34, 92
T
tools required 36
top cover
removal 73
spare part number 20, 34, 73
TouchPad
buttons 7
identifying 7
spare part number 20
TouchPad on/off button,
identifying 7, 9
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TouchPad on/off light, identifying
8
transporting guidelines 39

WWAN antenna and cables
spare part number 25
WWAN antennas, identifying 14
WWAN module
removal 53
spare part numbers 22, 29,
30, 53

U
upgrade bay
identifying 12
upgrade bay hard drive
removal 57
spare part number 57
spare part numbers 30
USB 3.0 board
spare part number 22
USB board
spare part number 34
USB port, identifying 12, 13
V
vents, identifying 13
video, product description 2
volume mute button, identifying

9

W
warranty period 41
Web browser light light 8
webcam 14
removal 72
spare part number 24, 34, 72
webcam cable
spare part number 25, 30
webcam light, identifying 14
webcam, identifying 14
Windows applications key,
identifying 10
Windows logo key, identifying 10
wireless
product description 3
wireless antenna
spare part number 30
wireless antennas, identifying 14
wireless button
identifying 9
wireless lights 8, 11
WLAN antenna and cables
spare part number 25
WLAN antennas, identifying 14
WLAN module
removal 51
spare part numbers 22, 29,
30, 51
workstation guidelines 39

